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GETTING STARTED 
 
Congratulations on your AccuSport Vector Pro Launch System purchase. 
You have chosen to do business with the leader in launch system 
technology. To validate the AccuSport warranty, receive notification of 
software updates and gain access to free technical support, please 
register your product by filling out the enclosed warranty card, or by 
going to www.accusport.com to complete the online registration. 
 
To ensure trouble-free, reliable operation, read this user guide before 
setting up and using your Vector Pro. Please visit the AccuSport web site 
at www.accusport.com for advanced topics and breaking news about 
AccuSport products. 

 

Vector Pro Launch System Components  

 

 

Note:  VFit and VTeach software ships standard with each Vector Pro 
purchase.  The VRange software is an add-on module that can be 
purchased for an additional cost. 
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About Computer Requirements 
 
 
 
Warning:  

This software is designed for computers running “Intel” 
Processors and Microsoft Windows Operating Systems (See 
Below) 

 AMD processors are not recommended 

 USB 3.0 not supported 

 Only Mini DV Cameras are supported in the VTeach 
Program. High Definition and Hard Disk Cameras are not 
supported 

 Windows XP 64 bit is not supported 

 Apple Macintosh products are not supported 

 NetBooks are not recommended 

 For further information call AccuSport Customer Support 
336 759 3300 Ext 2 

 
 
 
The VSeries Software works with personal computers that meet the 
following computer requirements on page 6: 
 
To check your computer’s specifications, select the “Start” button (Win 
XP) or “Logo” (Win 7 or Vista). Right Click on the “My Computer” label 
(Win XP) or “Computer” label (Win 7 or Vista). A small context menu 
will appear. Left-Click on “Properties” this will display your computer 
specifications. Compare with the following to ensure the computer 
meets the requirement.  
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Computer Requirements (Windows XP, Vista, Windows 7): 
 
CPU:  

 Minimum - Intel (only) Core2 duo with 2.0 GHz processor; 
 Recommended – Intel iSeries, i5 & i7, 2.4 GHz processor or above 

 
Operating System (O/S):  

 Minimum – Windows XP (32 bit only), Service Pack 3 (SP3)  
 Recommended – Windows 7 (32 and 64 bit O/S) 

 
Memory:  

 Minimum 3 GB  (2GB Windows XP) 
 Recommended  4 GB (or above with 64 bit O/S) 

 
Hard Disk: 

 Minimum 80 GB  
 Recommended 250+ GB 

 
Drive:  

 CD/DVD 
 
Video Card:  

 Minimum 32 bit color, 1024 x 768 resolution, Microsoft Direct x 
9.0, 128Mb Onboard 
Memory, VGA/DVI/HDMI port (2 ports recommended for dual 

monitor support) 
 

Ports:  
 USB: One available USB 2.0 Port (for Vector Pro) 

 
Video Camera Port (Optional): 

 Connecting video camera via  IEEE 1394A (FireWire) 
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Video Camera Specifications: 
 
WARNING: Hard Disk and Hi Definition cameras are not supported.  
For Video instruction, only Professional (Firewire) and Mini- DV (tape) 
live-streaming cameras are recommended. 

 Microsoft Windows (Windows Driver Model (WDM)) Compliant 

 Digital - not analog 

 FireWire connection to computer 

 30 frames per second minimum 

 Resolution: x 480 pixels minimum; 720x480 maximum 

 Ability to manually adjust shutter speed 

 Gain adjustment (light amplifier) 

 Wide Angle Lens (optional) 

 
Safety Instructions  
 
 Follow all warnings and instructions marked on the product. 

 Do not drop the Vector Pro or subject it to mechanical shocks. 

 When taking a swing, do not hit the Vector Pro. 

 Install the protective shields before first use, and always use the 
protective shields to avoid damage to the Vector Pro. 

 Do not open the Vector Pro unit. It contains high voltages and delicate 
components. Opening the Vector Pro could result in personal injury or 
harm to the unit, and will void the warranty. 

 Do not allow moisture to enter the Vector Pro.   

 Use only approved accessories. To prevent harm to the Vector Pro or the 
computer system, use only the supplied cables and power adapters. 

Care and Handling 
 
 The Vector Pro unit contains a rechargeable battery. To recharge the 

Vector Pro, turn off the unit, connect the supplied AC adapter and plug it 
into an AC outlet overnight or for at least 6 hours.  

 When necessary clean the Vector Pro lenses using any photographic or 
eyeglass cleaning kit. Paper towels or tissue are not recommended. 

The outside of the Vector Pro case can be cleaned using a damp cloth. Turn 
off and disconnect the Vector Pro before cleaning. Do not allow liquid to 
enter the case.  
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AccuSport Vector Pro Illustration  
 
 
 
  
 

Plug USB Cable 
here to connect 
to computer. 



User Guide Page 9 April 2012 

Prior to Software Installation – Windows XP 
 
The following steps should be taken to prevent the Windows XP 
Operating System from shutting down the computer’s USB ports, and to 
prevent the Computer from slowing down its processor speed, while the 
VSeries software is in use. 
 
Power Options Settings 
 

1) Select the Windows XP Start Button 

2) Select the Control Panel 

3) Select Power Options  

4) Under Power Schemes, use the drop down to select Always On.  

5) Click Apply, then OK at the bottom right side of this window. 

 
USB Power Saving Settings 
 

1) Select the Windows XP Start Button 

2) Right-Click on My Computer  

3) Select Manage 

4) When the ‘Computer Management’ window opens, select Device 

Manager 

5) Scroll down the hardware list on the right until ‘Universal Serial Bus 

Controllers’ is visible 

6) Select the Plus (+) sign next to ‘Universal Serial Bus Controllers’ and the 

USB devices will be revealed. 

7) Right-click on the first ‘Root Hub’ listed and select Properties 

8) From the ‘USB Root Hub Properties’ window, select the Power 

Management tab 

9) Uncheck the box labeled “Allow the computer to turn off this device to 

save power” 

10) Click OK at the bottom of this window.  

11) Repeat steps 8 through 11 for all the remaining ‘Root Hubs’ listed under 

the ‘Universal Serial Bus Controller’ heading 
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Prior to Software Installation – Windows Vista and Windows 7 
 
The following steps should be taken to ensure the Power Options on a 
Windows Vista or Windows 7 based computer are set correctly in order 
to work with the VSeries Software. 
 
 
Power Options Settings 
 

1) Select the Windows Start Button 

2) Select the Control Panel 

3) Select Power Options (You may have to Select the “Classic View”  link 

in the top right corner of the window in order to view the ‘Power 

Options’ icon) 

4) Select High Performance (you may need to click ‘Show Additional Plans’ for Windows 7) 

5) Next, select Change Plan Settings 

 
Note: For the following procedure the “On Battery” setting is only available on 
laptop computers. For Desktop computers the “On battery” and ‘Plugged In” labels 
are not present but the layout is similar. This procedure can still be used to ensure 
Desktop Computers with power saving features are set-up correctly for the Vector 
Pro. 
 
6) Select  the Put the Computer to Sleep option   

o Set “On Battery” to Never by clicking on the down pointing arrow 

next to the “minute” numerals and selecting ‘Never’. 

o Set “Plugged In” to Never by clicking on the down pointing arrow 

next to the “minute” numerals and selecting ‘Never’. 

7) Select the Change Advanced Plan Settings link. (A new window will 

be displayed) 

o Select the plus (+) sign next to the Hard Disks label and set all 

displayed “Minutes” to read Never by holding down the left 

mouse button on the down pointing arrow next to the minute 

numerals until the “Minutes” display reads ‘Never’. 

o Select the plus (+) sign next to the “Turn off Hard Disks After” 

label Set all displayed “Minutes” to read Never by holding down 

the left mouse button on the down pointing arrow next to the 

minute numerals until the “Minutes” display reads ‘Never’. 

o Select the plus (+) sign next to the Sleep label 
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 Select the plus (+) signs next to “Sleep After,” and set all 

displayed “Minute” fields to read Never or Off by holding 

down the left mouse button on the down pointing arrow 

next to the minute numerals until the “Minutes” display 

reads “Never” or “Off” 

 Select the plus (+) sign next to “Allow Hybrid Sleep,” and 

set all displayed “Minute” fields to read Never or Off by 

holding down the left mouse button on the down pointing 

arrow next to the minute numerals until the “Minutes” 

display reads “Never” or “Off” 

 Select the plus (+) sign next to “Hibernate After”, and set 

all displayed “Minute” fields to read Never or Off by 

holding down the left mouse button on the down pointing 

arrow next to the minute numerals until the “Minutes” 

display reads “Never” or “Off” 

8) Select the plus (+) sign next to the USB settings label. 

o Then, select the plus (+) sign next to the “USB selective suspend 

setting” label. 

o Ensure both fields read Disabled. If they do not, select the down 

pointing arrow for each field , in turn, and select “Disabled” 

9) Select the plus (+) sign next to the Processor Management label 

o Then, select the plus (+) sign next to the “Minimum Processor 

State” label  

o Change settings for the “On Battery” and “Plugged In” labels to 

100 percent (%) by holding down the left mouse button on the up 

pointing arrow next to the percentage (%) display till it reads 100 

percent (%) 

o Then select the plus (+) sign next to the “Maximum Processor 

State”  

o Change settings for the “On Battery” and “Plugged In” labels to 

100 percent (%) by holding down the left mouse button on the up 

pointing arrow next to the percentage (%) display till it reads 100 

percent (%) 
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10) In the bottom right corner of the page select Apply and then OK. 

11) The previous Power Options Settings page is now displayed, select the 

Save Changes key. 

12) Exit the final Power Options window by clicking the Red –“X” button to 

complete your set-up.  

13) Turn Vector Pro Off 

14) Restart the Computer 

 
 
Disabling User Account Control (Windows Vista and 7)  
 
We recommend disabling the User Account Control to prevent the 
Windows Vista or 7 Operating System from blocking the VSeries 
installation or causing an error message on opening the application.   
 
*Changing UAC settings after installation may cause software to 
become unstable.  Do NOT change UAC settings after installation.   
 
 

1) Left Click on Start 

2) Left Click on Control Panel 

3) Left Click on User Accounts (If you cannot see a "User Accounts" Icon 

click on the "Classic View" link in the left hand column of the 

window, then repeat the first part of step 3) 

4) Left Click on Turn User Account Control On or Off (Vista); 

Change User Account Control Settings (Windows 7) 

5) Uncheck the User Account Protection checkbox (Vista); 

Position slider at bottom to Never Notify (Windows 7) 

6) Click on OK 

7) Left Click on Yes to Restart the computer 

 
Please call AccuSport Customer Support (336) 759 3300 x2, or e-mail 
support@accusport.com, if any problems are encountered while 
following this procedure.  Note: Some versions of Vista and 7 do not 
allow for users to disable the User Account Control. 
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Software Installation (Windows XP, Vista, and 7) 
 
Install and configure the VSeries Software before connecting a Vector 
Pro to the computer.  
 
If the software does not run automatically, go to the “Start” button (Win 
XP) or “Logo” (Win 7 or Vista). Left-Click on the “My Computer” label 
(Win XP) or “Computer” label (Win 7 or Vista) and double-click the 
Setup.exe file. 
 
The following steps are for Windows XP.  Though cosmetically different, 
the Windows Vista and Windows 7 installations follow the same 
procedure.   
 
 
Software Installation: 
 
1. Select OK to start the software installation. 

 
 

2. When the VSeries Setup Wizard displays, Select Next.  
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3. The “Choose Install Location” window will display, click Install.  
Always install the software to the default location C:\Program 
Files\AccuSport\vSeries. 

 
   
4. The software will begin to check your system for required updates 
and install the software 
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5. The Microsoft Visual C++ Setup window* may appear. Select Next to 
continue the installation. 
*This window may not appear if the update is already on your system.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
6. Check the “I have read and accept the license terms” checkbox, the 
install button will no longer be grayed out, then select Install to 
continue the installation.  
*These windows may not appear if the update is already on your system. 
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7. The update will install. Select Finish once complete. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
8. The VSeries software will now install the Microsoft Net Framework 3.5 
SP1 Update*. Check the “I have Read and “Accept the terms of the 
License Agreement” checkbox and click Install.  
*This window may not appear if the update is already on your system. 
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9. The Microsoft Net Framework 3.5 SP1 Update may take some time to 
install.  Once completed, click Exit. 
*These windows may not appear if the update is already on your system. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
10. The VSeries software will now launch the Adobe Reader Setup*. 
Select Next to install the software.  
*This window may not appear if the update is already on your system. 
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11. Select Install to install the Adobe Reader software.  
*These windows may not appear if the update is already on your system. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
12. Once the Adobe Reader software has completed its installation, click 
Finish. 
*This window may not appear if the update is already on your system. 
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13. The VSeries Software will now install. Click Next to continue.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
14. Select Finish to complete the installation of the VSeries Software. 

 
 
 
 
Once the software is installed, complete the relevant Vector Pro 
Hardware installation procedure.  
 

 
*After installing the software, you can access the User Guide at 
any time by clicking ‘Help’ in the toolbar of the Software. 
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Hardware Installation (Windows XP) 
 

Driver Installation procedure 

1. Ensure the VSeries Software is installed before starting this procedure. 

2. Install the two Vector Pro protective shields. The product warranty will not 
cover the damages to the unit during use without shields. 

3. Use the AC adapter to connect the Vector Pro to a power source.  

4. Use the USB cable to connect the Vector Pro to the USB port on the computer. 

5. Fold down the rear foot on the Vector Pro and set the unit on the ground. 

6. Power on the Vector Pro and two High pitched beeps will sound.  

7. The “Welcome to the Found New Hardware Wizard” page will appear select 
“Install From a Specific Location” and click “Next” 

 

 

 

 

 

 

 

 

 

 

 

 

 

8. The “Please choose your search and Installation options” page will appear. 
Select “Don’t Search I will choose the driver to install.” Click “Next.”    
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9. The “Hardware type” page will appear. Scroll down and Select the “Universal 
Serial Bus Controllers” label. Click “Next”  

 

 

 

 

 

 

 

 

 

 

 

 

10.  The “Select the device driver you want to install for this hardware” page will 
appear. Click “Have Disk” 

 

 

 

 

 

 

 

 

 

 

 

 

11.  The “Install From Disk” page will appear. Click “Browse” 
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12. The “Locate File” page will appear. Click inside the “Look in” narrow drop down 
box.  

Navigate to the “C:\Program Files\AccuSport\vSeries\vs_vpProcess\Drivers” 
folder 

 

 

 

 

 

 

 

13. In the “Locate File” page Select the “VectorPro” file and click “Open”  

 

 

 

 

 

 

 

 

 

 

 

 

14. The “Install From Disk” page will appear again. Click “OK” 
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15. The “Select the device driver you want to install for this hardware” page will 
appear. Click “Next” 

 

 

 

 

 

 

 

 

 

 

 

 

 

16. The first Vector Pro Driver will install.      
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17. The “Found New Hardware Wizard page will appear. Click “Finish”  

 

 

 

 

 

 

 

 

 

 

 

 

18.  Once the first driver has installed a second found new hardware wizard should 
appear. Repeat steps 7 through 17 to install the second driver 

19.  To ensure both Vector Pro drivers have been installed: 

 Left Click the Windows XP “Start” Button 

 Right Click the “My Computer” label 

 Left Click “Manage” in the context Menu 

 In the “Computer Management” window select “Device Manager” 

 On the right side of the “Computer Management” window scroll down to 
the “Universal Serial Bus Controller” label. Click on the plus (+) sign 

 The Vector Pro drivers should both be listed and should have no 
exclamation or question marks over them, as shown below. 

  

 

 

 

 

 

 

 

 
NOTE: If a driver is not installed, right-click on the driver and left-click on ‘Update 
Driver’ then repeat steps 7 through 16  

NOTE: Always use the same USB port on the computer that the drivers were initially 
installed on.  Otherwise, you may have to reinstall the drivers.  
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Hardware Installation (Windows Vista , Windows 7 (32/64 bit) 
 

 

Driver Installation procedure 

1. Ensure the VSeries Software is installed before starting this procedure. 

2. Install the two Vector Pro protective shields. The product warranty will not 
cover the damages to the unit during use without shields. 

3. Use the AC adapter to connect the Vector Pro to a power source.  

4. Use the USB cable to connect the Vector Pro to the USB port on the computer. 

5. Fold down the rear foot on the Vector Pro and set the unit on the ground. 

6. Power on the Vector Pro and two High pitched beeps will sound.  

7. If the “Found New Hardware” window appears, click Don’t show this 
message again for this device. 

 

 

 

 

 

 

 

 

 

 

 

 

8. Go to the Start menu, right-click ‘Computer’ and choose Manage.   
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9.  On the left, choose Device Manager. 

 

10. Locate the two ‘Unknown Devices’ with yellow exclamation marks next to 
them. (Note: If you have installed the Vector Pro on this computer before, 
they may be listed as Vector Pro’s with yellow exclamation marks, and found 
under ‘Universal Serial Bus Controllers’.  The procedure will be the same.)   

 

11. Right-click on the first “Unknown Device” and choose Update Driver 
Software 
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12.  The “Found New Hardware” wizard will appear. Choose Browse my 
computer for driver software (advanced). 

 

 

 

 

 

 

 

 

 

 

 

13. The “Browse for driver software on your computer” page appears. Choose Let 
me pick from a list of device drivers on my computer, and click Next.  

14. The “Select the device driver” page will appear.  Click Have Disk. 
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15.  The “Install from disk” window will appear.  Click Browse. 

 
 

16. Browse to C:\Program Files (x86)\AccuSport\VSeries\vs_vpProcess\Drivers 

Note: On 32-bit operating systems, the Program Files folder will not have (x 
86) and the folder will just be named ‘Program Files’) 

17. Select VectorPro.inf and click Open.  
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18. The “Install from Disk” window appears again.  This time click OK. 

 

19. The “Select the device driver” page appears again.  This time click Next. 

 

 

20. If the “Windows Security” window appears, Click Install this driver software 
anyway 
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21. After the driver has installed, the “Windows has successfully updated your 
driver software” page appears. Click Close to complete the first driver 
installation. 

 

 

 

 

 

 

 

 

 

22. Go back to step 12 to install the driver for the second Unknown Device. 

 

23. To verify that both drivers have been installed correctly, scroll down to the 
“Universal Serial Bus Controllers” label. Click on the plus (+) sign. The ‘Vector 
Pro’ drivers should both be listed and should have no exclamation or question 
marks over them, as shown below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

NOTE: If a driver is not installed (still has yellow exclamation mark), repeat steps 12 
through 23  

NOTE: Always use the same USB port on the computer that the drivers were initially 
installed on.  Otherwise, you may have to reinstall the drivers.  
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BEFORE USE 
 
 
 
Charging the Battery 

 
To charge the battery, plug the Vector Pro into an outlet via the AC 
adapter.  Make sure the Vector Pro unit is turned Off, and allow the unit 
to charge overnight or for at least six hours. 
 
If you are using a fully charged battery, no AC power source is needed 
(allows for 2-3 hours of use).  If the battery is not charged, or if you will be 
using the Vector Pro for an extended time period, use the AC adapter to 
plug into an electrical outlet. 
 
 
 
 
 
Marking the Ball  
 
The VSeries software uses black marks on the golf ball to measure spin. 
The marks must face the unit camera lens vertically when the ball is 
positioned for hitting. No other ball marks should be visible to the 
camera.  If making your own marks, they should be made using a black 
sharpie on a blank face of a white ball. 
 

Logo Method - Most golf balls on the market today 
provide a marking with a straight line type orientation 
as pictured, or you may also use the stripe method 
below. 
 
 
 
Stripe method - Draw a 1/8” black stripe at least one 
inch long on the blank face of the ball. The mark must 
be clearly visible when it is facing the camera lens and 
must be drawn perfectly straight. There are a number 
of golf ball marking devices commonly used in the 
industry which will work for striping the ball for use 
with the VSeries software. 
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Starting the Software 
 
Power on the computer and connect the Vector Pro to your computer via 
the USB cable. Double click the VFit ,   , VTeach  ,   , or VRange       icon 
on your computer desktop to start the software.  Once the software has 
opened, power on the Vector Pro unit.   
 
 
 
 
 
Importing the Database 
 
The first time you open your VSeries software, you will be prompted to 
import the database from a previously installed version of software.  
 
 
* If you do not have a previous version of software installed, simply 
click Exit.   
 
 
 

If you do have a 
previous version of 
software installed, 
check the 
corresponding box(es) 
and click Import.  The 
software will 
automatically render 
your database for 
access in the new 
software that you are 
installing.  
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SOFTWARE FEATURES 

 
Navigating the User Interface  

 
Session, score, ball launch measurements, ball flight information and 
student data are displayed in the same manner for each software 
module . That information and the toolbar menu options are explained 
here, beginning in the upper left corner of the software, and then 
moving clockwise around the screen.  
 

V ideo  Camera  Connec ted :  The black camera icon in 
the upper left corner glows green when a digital camcorder is 

connected and recognized. 
 

Vector Pro Connected: The black AccuSport logo in the upper 
left corner of the software glows green when the Vector Pro is 

connected and recognized.   
 

 
Toolbar: Select features, change 

preferences and settings within the software, and access options not 
available on the main software screen.  See page 24 for detailed view   
 
 

Clear Session: Clears all shot data and plots on the screen. 
 

 

 
Ball Flight Analysis: Carry, offline and total distance appear across the 
top of the screen. White numbers show data from the current shot. Gold 
numbers show the average of all shots in that item.  
 
Total Distance includes carry and roll. The direction offline will be 
represented by an “R” for Right and an “L” for Left. 
 
 

Full-Screen Mode: In VRange, this opens the range in full-screen 
mode for a true simulation experience.  In VTeach, this opens the 

video capture window in full-screen mode for better viewing.  VFit does 
not have any functionality for this button.   
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Minimize: Minimizes the software screen (sends to task bar) 
 
 
Maximize: Maximizes the software screen (allows software to fill 
your monitor) 
 
Restore: Restores the software screen to the size determined by 
your monitor’s resolution setting.  
 
Close: Closes the software.  
 

 
Trigger Delay: Toggle between Fast-Medium-Slow 
according to the player’s swing speed or club choice (Fast 
for drivers, Medium for irons, and slow for wedges) 
 

 

Score: The software scores each shot, in a range from 0 to 100, 
based on all the parameters of that shot.   

 
 
 
 
 
Launch Dials 
 
The launch dials located at the bottom of the software convey launch 
data information for every shot. 
 

Ball Speed: Measures in miles per hour (MPH), feet per   
second (FPS), kilometers per hour (km/h) or meters per 
second (m/s). To change units, click 
Options>Preferences. 

Club Speed: Calculates within 1 to 2 miles per hour 
(MPH), feet per second (FPS), kilometers per hour (km/h) 
or meters per second (m/s). To change units, click 
Options>Preferences. 

Launch Angle: Displayed in degrees. 
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Descent Angle: Calculated angle of the golf ball in 
relation to the ground as it descends from the apex of 
its flight. 
 

 
 
Back Spin: Displayed in RPMs. 
 
 
 

Side Spin: The label below the number indicates 
draw/hook, fade/slice, or center.  Displayed in RPMs.   

 

Side Angle: The label below the number indicates push, 
pull or center. Displayed in degrees. 
 

 

 
 
 
File Menu 
 

 
 
 
 
 
 
 
 

 
Exporting to Microsoft Excel: If you already have Microsoft Excel on 
your computer, you can click the Export to Excel from the Options Menu 
to export text to an excel spreadsheet.  
 
Exporting to Text File: You may click the Export to Text icon to export 
shot data to a text file.  
 
Reports: Generates a printable version of 
your session.  Choose between the Full 
Report to see all shots, or Average Report 
to see only item averages.  You may also 
add notes that will be appear on the printed 
page.  See the Appendix for examples 
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Set Company Information: You can personalize your reports by 
updating your company information.  This information will be included 
on all printed reports.   
 
Import VectorX Session*: Imports a VectorX session that was saved 
to flash drive. *Not applicable to Vector Pro 
 
Exit: Closes software 
 
 
 
 
 
Options Menu 
 

 

 
 
 
 

 
 
Preferences: 

 
• Weather: Conditions under which 
you are hitting the ball. Wind 
direction should be set at zero 
degrees if the ball flies directly into 
the wind, at 180 degrees if the ball 
flies downwind, at 90 degrees if the 
wind is coming from the right, and 
at 270 degrees if the wind is 
coming from the left.  
 
• Default: Button in the weather 
box restores default settings. 
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• Qualify Shots: If the software cannot analyze a shot correctly, 
usually because there is something wrong with the image, it will 
not produce shot data and will display ‘Analysis Terminated’ in the 
image window.   

 
 
 
         By unchecking this box, you will force the software to show data 

for every shot hit, even if the image cannot be analyzed correctly.  
This setting allows you to capture video in VTeach without the 
need for a processed shot in the software.  For more information on 
capture options, see page 39.   

 
         • Units: Measurement for distance and ball and club head speed.  
 
         • Score: The Shot Score system scores each shot in a range from 

0 to 100, based on the flight efficiency related to ball speed. Shot 
Score takes into account all measured variables in the launch 
data.  Power Transfer Index (PTI), also known as Smash Factor, is 
simply a quotient of ball speed over club speed, and is an older 
scoring technique first used when speed was the only information 
available in ball flight measurement. The PTI number will usually 
fall somewhere between 1.4 and 1.5. 

 
         • Tracer Colors: ‘Standard’ will plot all shots in white by default in 

the shot profile and in the VRange software.  Choosing ‘Club 
Grouping’ will automatically assign a new color to each new item 
that is added, for ease in comparing different items.   

 
         • Warnings: If this box is checked, a reminder that the session will 

not be saved will appear after the first shot is hit if a student session 
has not been set up.  If you do not wish to set up a student session 
and automatically save the data, you can click Ok and continue with 
the hitting session.   

 

 
 
Set Launch Monitor: Select between Vector Pro or VectorX depending on 
which unit you are using in conjunction with the software.   
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Advanced Mode:  

 
The Advanced 
Mode displays 
detailed 
information 
about the golf 
shot including 
the images from 
the top and 
bottom cameras, 
microphone 
trigger settings, 
and image 
enhancement 
options including 
mono, edges, 
marks, and 
plane.  In 
addition, there is 

a focus mode for manually focusing and setting the brightness of the 
cameras.  In a few cases, AccuSport Customer Support may ask you to 
adjust these settings with their supervision.  
 
The Trigger Setting will display the following: 
 

Default sensitivity should be used for all 
clubs and hitting conditions.  Fast delay is 
appropriate for most conditions.  Slower 
swing speeds and iron shots may require 
the Delay be set to medium or slow.   
 

 
Calibrate: (Vector Pro Only) 

 
Calibration sets the brightness and focus of the 
two camera lenses.  Use Calibration at setup 
and when lighting conditions change. 
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View Menu 
 
 

 
 
 
Plotting: Selecting Single will plot only one shot at a time on the shot 
profile and in VRange; this shot is either the last shot hit or the shot 
currently selected in the shot history window.  By selecting All, every 
shot will be plotted, with the last shot hit (or currently selected) 
displayed brightly and all others transparent.   
 
*The view Menu options are different in the VRange software.  Please refer to page 45 
for details 
 
 

 
 
Help Menu 
 
 

 
 
 
Vector Pro Firmware: Displays the current version of firmware within 
the Vector Pro unit itself. (This option may not be present)   
 
User Guide: Opens User Guide (PDF format) 
 
About VFit (VTeach/VRange): Displays software version 
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Managing the Student Database   

 

Select Student: To enter new student 
information or to access stored data from a 

returning student, click the student arrow to open the database.  All 
shots hit with a student selected will be automatically saved.   
 
 

1) Choose between New Student or 
Returning Student. 
 
 
 
 
 

2a) For a new student: Click New Student, 
then enter name and contact information. 
Click Next to proceed to entering Activity 
information.   
 
 
 
2b) For a returning student: Choose your 
student from the list.  If you do not see the 
student listed, enter the student’s first or last 
name and click Search. Click to highlight the 
desired student and click Next.   
 
You will now have the option to either begin a 
new session with this student, or 
continue/view a previous session.  To continue 
or view a previous session, click Continue 
Session – this will take you directly to the 
session.  If you wish to start a new session, 
click Start New Session to proceed to 
entering Activity information.   
 
3) Select Activity: Choose from the list of 
activities or create your own.  In the future, 
this will help you identify what took place in a 
session when viewing previous sessions. 
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4) Select Item: A particular list of items will 
be displayed according to which activity was 
chosen.  You can also add new items by 
clicking Create New.  Items can be clubs, 
heads, shafts, or balls and will serve as an 
identifier throughout your session.   
 

 
 
5) Click Done to close the window and begin your session.  You will 

notice that the Student Name, Item, and Activity are now displayed 
in the student information bar at the bottom of the screen.   

 
 

 Select Item: During a session, you may 
want to compare different items.  Click the 

item arrow and choose the next item you wish to compare.  After your 
item is selected, click Done and your next shot will begin a new average 
line for that item.   
 

Activity: Displays the Activity selected 
during the student/session set up process. 

Once a session has begun with a specific activity assigned, you cannot 
change the selected activity.  This section is for display only.   
 
 
 

---------------------------------- 
 
**Once a Student, an Activity, and an Item have been specified, 
all shots hit within that session will be automatically saved. 
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SETTING UP 
 
Calibration 
 

It is recommended that you calibrate the Vector 
Pro before each use to ensure that you receive 
accurate data.  Go to the Options menu and click 
Calibrate.  
 

 
Using your Setup Template and black calibration 
tee, position the ball within the dotted green 
target and click Calibrate. 
 
 
 
 
 
A message will appear stating that the Calibration 
is Complete.  Click Ok and you will be taken back 
to the main software screen. If calibration is not 
successful, go back and repeat the calibration 
process, making sure there are no foreign objects 
in the picture.     
 

 
 
Positioning the Ball 
 

Use the Setup Template to tee up the ball in 
the correct position. If you are not using the 
Setup Template, review the setup illustration 
on page 32, to understand the golfer position 
and hitting zones. Tee the ball up in the 
Right Tee Zone for a right handed golfer. 
 
 
For a left handed golfer, tee up the ball up 
in the Left Tee Zone.  
 
 

 
 
 
*Note: Do NOT leave Setup Template in place when hitting shots 

left tee 
zone 

right tee 
zone 
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Positioning the Vector Pro, Laptop Computer, Video Camera  
 
Diagram shows positioning for right handed golfers. 
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Hitting your first shot 
 
After hitting the ball, review the image in the right corner of the 
screen. To measure ball flight parameters accurately, the 
software needs 2 complete golf balls in the image window. If a 
clear ball image does not appear, or if you receive the message 
“Analysis Terminated,” go to Options and open the Advanced Mode. 
The marks on each ball should be clear, ball dimples should be 
distinguishable and ball outlines should be completely visible, not fading 
into darkness or cut off the edge of the screen. For further 
troubleshooting, refer to page 64.   
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VFIT SOFTWARE 
This section describes software features unique to the VFit Module. 

 

 

 

The top of the Fitting Screen contains the Shot History Table. Click the 
tabs located in the middle of your screen to change the lower window to 
display Analysis, Profile or Club Impact. When you click to highlight a 
row in Shot History (shown in blue), the data from that shot appears in 
the lower windows. 
 

Please refer to pages 13-33 for standard information regarding the 
software installation, software features, managing student information and 
calibration.   
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Shot History Table 
 

 
 
In the Shot History table, data is grouped and summarized by item 
within the gold colored line of each group (as shown above). Click on the 
+/- box in the item field to collapse the data to display average lines 
only for each item.  
 
Individual or item averages may be selected for plotting in the Profile 
view. To plot an item, click on the tab labeled Profile, click the box in 
the plot column of Shot History for a particular shot or average; select a 
color for plotting that item.  
 
To delete a shot in the Shot History table, select the row, right click on 
it and then click delete shot. 
 
Reset Plots: Resets plots to default colors depending on selected 
‘Plotting’ option (view menu).  
 
Show Averages Only: Collapses all items’ individual shots under their 
respective average lines for easy comparison.   
 

Expand Table: Click on this icon to display an expanded view 
of the shot history table.   
 

‘What if’ Analysis 

The ‘What If’ Analysis allows you to 
input different launch information for 
shot comparison.  Launch information 
may be modified, analyzed and 
compared to other shots. After filling 

in launch condition values such as speed, spin, launch angle, side spin 
and side angle, click Analyze to update. Then select Clear to return to 
the original data. Clear must be selected after each analysis in order to 
be able to select another shot in the Shot History table.  
 
*The software will auto-detect right or left handed after a shot is hit. If using the 
‘What If’ feature without any shots hit, you must specify Right or Left handed in order 
for data and plots to be correct. 
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Image Window 

The Image Window is located 
in the lower right corner of the 
software and shows a composite 
image of the ball from the top 
and bottom cameras. The 
Vector Pro Launch System 
requires a black mark on the 
golf ball to measure spin; those 
marks are indicated in red by 
the software to validate that the 
shot was marked correctly. 

 
*If the software misreads the black marks, the ball can be remarked by 
clicking once on each end of the appropriate mark.  Error messages can 
also be viewed in this window to assist in troubleshooting problems 
related to shot capture.  If you wish to delete the last shot, click the 
Delete Shot button in the lower right corner 

 

 

 

Shot Analysis 
 

Click the tab in the middle of 
the screen labeled Analysis. 
The chart displays various 
computed launch angle and 
back spin conditions. The 
Yellow box shows the 
distance achieved by the initial 
launch conditions. Surrounding 
cells show the distances of 
various launch angle and spin 

rate combinations. If a box is Black, there is no significant gain or loss 
in distance. Red indicates a loss of distance and Green indicates a gain 
in distance. 
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Shot Profile  
 

Click the tab labeled 
Profile. Here, you are 
able to view either a Side 
Profile or Top Down profile 
by selecting the 
corresponding toggle in 
the upper right.   
 
 

 
Plotting Options: In the ‘View Menu’, select All to display tracers of 
every shot during a session or select Single to display only the current 
shot.  Plot colors can be set via Tracer Colors in ‘Preferences’ to 
Standard (all white) or Club Grouping (automatically assigned colors per 
item).  You may also manually assign a plot color at any time in the 
Shot History table in the Plot column.   
 
*The current shot hit, or currently selected, will always be the 
brightest shot plotted.   
 
Launch data may be modified for a “What If” plot. Change the values in 
the ‘What If’ Analysis window and then click Analyze to see the plot of 
a hypothetical shot (shown in white). 
 
 
 
 
 
Club Impact 

 
Click the tab labeled Club 
Impact. This tab shows 
angle of attack, swing 
path, and indicates 
whether the face was open 
or closed at impact. 
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VTeach Software 
 

This section describes software features unique to the VTeach Module. 
 

 
 
 

Please refer to pages 13-33 for standard information regarding the 
software installation, software features, managing student information and 
calibration.   

 
 
 
Video Camera Selection 
 
If you wish to use a video camera, follow these steps for selecting and 
setting up the camera in the VTeach software.   
 
1. Power on the video camera and computer. 

2. Plug the camera into the computer. 

3. Start the VTeach software by double clicking the VTeach icon on your 
computer desktop.  
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4. When the Camera Selection window 
appears, click the camera drop down and 
select your camera. If your camera allows, 
you can change the format (do not exceed 
720x480) and adjust the framerate.  You 
also have the option to change PreRoll 
(duration of video captured before impact) 
and PostRoll (duration of video captured 
after impact). *If you are not using a video 
camera, click Cancel.   

5. Click Set to close the dialog box and 
begin using the software. 

 

*The camera icon in the upper left corner of the VTeach software will glow green when a 
video camera is connected. It will be black if no camera is connected. 

 

Capturing Video 

 

Live Mode: To see a live view to aid in setup and positioning of the 
camera, click Show Live at the top of the video window. 

 

Capturing Video: Video is captured with each processed shot.  If a shot is 
not processed and you see ‘Analysis Terminated’ in the image window, 
video will not be captured. 

    

To capture video without requiring a processed shot, go to Options and 
click Preferences.  Uncheck the box next to Allow Analysis 
Terminated.  Shots will appear in the shot history table to allow you to 
select between your captured video, but will not contain any shot data.  
Use either of the methods below to trigger the camcorder.   

1) Use the Vector Pro unit to trigger the camcorder.  You are not 
capturing shot data, so it does not have to be in the correct 
hitting position as long as the sound of impact is able to trigger 
the microphone.   

2) Press Alt+T on your keyboard to trigger the camera as the 
player strikes the ball.  It is advised that you set the PreRoll 
and PostRoll each to 3 seconds as a buffer to ensure the entire 
swing is captured.   
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Swing Video Diagram  
    

 
 
 
 
 
 
 
Swing Video Navigation 
 
Use the video navigation buttons to play/pause, stop, play at quarter 
speed, or step the video clip forward or backward.  Click and drag the 
slider just below the Swing Video window to step the video forward, 
backward or pause it at a particular spot. 
 
 
On Screen Annotation  
 
To use the drawing tools for swing video annotation, pause the video at 
the spot at which you wish to draw. 
 

Click the Line Tool, then click and drag the pointer across the 
video image to draw a straight line. 

 
Click the Circle Tool, then click and drag the pointer across the 
video image to draw a circle. 

 
*Right-click on a drawn line or circle to modify or delete it. 

 

Step 
Backward 

Pause 

Slider 

Draw 
Straight  
Line 

Step 
Forward 

Play Stop Quarter 
Speed 

Draw 
Circle 
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Shot History 
 

The Shot History table allows 
you to view and select any 
shot from the session.  Note 
that shots with swing video 
attached will have a ‘Yes’ in 
the video column.   
 
*This table can be expanded down 
over the shot profile by clicking the 
yellow arrow at the top.   
 

 
 
 
Club Impact 

 
The Club Impact window 
shows angle of attack,  
swing path, and indicates 
whether the face was open or 
closed at impact. 
 
 
 
 
 

 
 
 
 
Shot Profile  
 

Profile shows a top down or 
side view of the ball flight 
based upon the measured ball 
launch information and 
AccuSport’s best-in-the-
industry flight model. 

 

*See page 47 for detailed view of Shot Profile 
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Image Window 

The Image Window is located 
in the lower right corner of the 
software and shows a composite 
image of the ball from the top 
and bottom cameras. The 
Vector Pro Launch System 
requires a black mark on the 
golf ball to measure spin; those 
marks are indicated in red by 
the software to validate that the 
shot was marked correctly. 

 
*If the software misreads the black marks, the ball can be remarked by 
clicking once on each end of the appropriate mark.  Error messages can 
also be viewed in this window to assist in troubleshooting problems 
related to shot capture.  If you wish to delete the last shot, click the 
Delete Shot button in the lower right corner 
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VRANGE SOFTWARE 
 

This section describes software features unique to the VRange software 
module.  The VRange software is serial number specific and must have a 
license key for the program to work beyond the evaluation period.  VRange 
is a separate add-on module to the VSeries software.  VRange can be 
displayed in four different range/hole views:  105yds, 155yds, 225yds, and 
325yds.   

 

Please refer to pages 13-33 for standard information regarding the 
software installation, software features, managing student information and 
calibration.   

 

VRange Demo 

A 14 day evaluation copy of the VRange software was included with your 
Vector Pro shipment.  It is also available for download at 
www.accusport.com.  To purchase VRange and to receive the license key 
(exclusive to specified Vector Pro unit serial number), contact Customer 
Support at 866-759-3302 ext. 2.   
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Expandable Windows 
 
Expand Window Tabs: Click on the green arrows to display 
windows of Shot History, Image View, ‘What If’ Analysis, Top Down 
View, and Profile.  
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View Menu Options (VRange only) 
 

Select View from the Options menu 
to display range options for distance, 
view aspect, day or evening effects, 
tracer type, and plotting preference.   
 
 
 
 
 

 
        • Distance: Four distance views are available in VRange: 105 

yards, 155 yards, 225 yards, and 325 yards.  
 
        • View Aspect: Center aspect is currently the only option 

available.   
 
        • Effects: The ranges can be viewed in either day or evening 

view. 
 
        • Tracers: Shots can be displayed in either line or ribbon format. 
 
        • Plotting: Select All to display tracers of every shot during a 

session or select Single to display only the current shot.  Plot 
colors can be set via Tracer Colors in ‘Preferences’ to Standard (all 
white) or Club Grouping (automatically assigned colors per item).  
You may also manually assign a plot color at any time in the Shot 
History table in the Plot column.   

 
 
Shot History 
 

Select the green tab at the top 
left to access the Shot History 
table. 
 
In Shot History, data is grouped 
and summarized under the gold 
colored average line for each 
item. Click on +/- box in the item 
field to collapse the data to 
display average lines only for each 
item.  
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Individual shots or item averages may be selected for plotting in the 
Profile and Range view. To plot an item, click the box in the plot column 
of Shot History for a particular shot or average; select a color for 
plotting that item.  The tracer changes to the plot color selection in the 
main range view, the top down view and the side profile view.  
 
To delete a shot in the Shot History table, right-click anywhere on the 
row and then click Delete Shot. 
 

 
 

 
Reset Plots: Resets plots to default colors depending on selected 
‘Plotting’ option (view menu).  
 
Avg Only: Check this box to display only the averages for each item. 
 
 

Click on the secondary expansion arrow to expand 
the shot history window to include all columns.  In 
expanded view, the arrow will then face left, and 
clicking it again will cause the window to revert back  
to compact view for better viewing of the range.   

 
 
 
 
 
Image Window 
 

Select the middle green arrow on the left to 
display the Image window.   
 
The image window shows a composite image of 
the ball from the top and bottom cameras. The 
software uses the black line on the golf ball to 
measure the spin; those marks are indicated in 

red by the software to validate how the shot was measured. If the 
software misreads the black marks, the ball can be remarked by clicking 
once on each end of the black line.  Error messages can also be viewed 
in this window to assist in troubleshooting problems related to shot 
capture. 
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“What if” Analysis 

 The ‘What If’ Analysis allows you to 
input different launch information for 
shot comparison.  Launch information 
may be modified, analyzed and 
compared to other shots. After filling in 
launch condition values such as speed, 

spin, launch angle, side spin and side angle, click Analyze to update. 
Then select Clear to return to the original data. Clear must be selected 
after each analysis in order to be able to select another shot in the Shot 
History table 
 
*The software will auto-detect right or left handed after a shot is hit. If using the 
‘What If’ feature without any shots hit, you must specify Right or Left handed in order 
for data and plots to be correct. 
 
Top Down View 

 
Select the top right green tab for a top down view of 
the shot profile.   
 
Colors can be set under Tracer Colors in 
‘Preferences’, or manually selected by clicking the plot 
cell in the Shot History table and selecting a color to 
compare different shot profiles within the software.   
 
 
 
 
 
 
 

 
 
Shot Profile View 
 

Select the bottom right green tab for 
a side view of the shot profile, which 
shows a top down or side view of the 
ball flight based upon the measured 
ball launch information and 
AccuSport’s best-in-the-industry flight 
model. 

 

*See page 47 for detailed view of Shot Profile 
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CUSTOMER SUPPORT 

 
You can reach AccuSport Customer Support by phone or email: 
Phone: 336-759-3300 x2 
Toll-free: 866-759-3302 x2 
support@accusport.com 
 
Please have your serial number available. 
 
HOURS:  Monday – Friday 8:00 am to 5:00 pm EST 
 
Free customer support during regular business hours. 
 
Weekend support available Saturday (10:00 am to 5:00 pm) and 
Sunday (1:00 to 5:00 pm). There is a per incident fee. 
 
If the Vector Pro warranty has expired, the customer is responsible for 
all shipping costs. 
 
Visit our website www.accusport.com for additional user tips.  
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FREQUENTLY ASKED QUESTIONS 
 
General Questions 

Whom should I contact with questions about Vector Pro or the 
AccuSport warranty? 
 
You can reach AccuSport Customer Support by phone or email: 
Phone: 336-759-3300 x2 
Toll-free: 866-759-3302 x2 
support@accusport.com 
 
Please have your serial number available. 
 
HOURS:  Monday – Friday 8:00 am to 5:00 pm EST 
 
Customer support is free of charge during the warranty period.   
 
Visit our website www.accusport.com for additional user tips.  
 

How can I get more information on Vector Pro? 
Contact our sales department at 336-759-3300 (or toll-free: 866-759-
3302). Press 1 for sales. Or email sales@accusport.com.  
 

How does Vector Pro connect to my computer? 
Vector Pro connects to your computer via USB 2.0. For capturing swing 
video at least one FireWire IEEE 1394 port is also required.  
 

Do I have the latest software version?  If not, where do I get it? 
To verify your software version, please contact Customer Support.  If 
your version it out of date, we can arrange for you to download a newer 
version of software if available.  If downloading the software is not an 
option, we can also send a CD, however, there is a charge for CD copies 
of the software. 
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How do I know if my computer has a USB 2.0 port? 
1. Right-click My Computer and select Manage.  

Note: Windows XP users may need to click Start to access My 
Computer. 
 
2. Click Device Manager. 
 
3. Click the (+) sign next to Universal Serial Bus Controllers (in the 
right windows pane). 
 
4. Manufacturer names are listed in front of each USB Host Controller or 
Root Hub. They should be labeled as follows; 

 i. If Enhanced Host Controller and/or USB 2.0 Root Hub Device 
are listed, then the computer has USB 2.0 ports. 
ii. If the phrases USB 2.0 or Enhanced do not appear with any of 
the USB references, then the computer has USB 1 or 1.1 ports. 
 

Note: If Universal Serial Bus Controllers is not listed, there is a problem 
with the USB controller or the USB controller is not enabled in the 
computer's BIOS. Please contact the computer or card manufacturer for 
updated drivers and/or for information on how to fix or enable the USB 
controller. 
 
How does Vector Pro work? 
Vector Pro is triggered by the sound of the club hitting the golf ball. The 
cameras capture two images of the ball, which are transferred to a 
computer. Advanced image analysis software determines the size, 
rotation, vertical path and distance between the two images. The 
software utilizes this information to accurately measure ball speed, 
launch angle, back spin, side spin and push/pull, and to calculate club 
head speed and angle of descent.  
 

Can I use irons with Vector Pro? 
Yes.  In addition to drivers, irons can be used on the Vector Pro with 
little to no adjustment. Keep in mind that the Vector Pro needs to be 
positioned at the same level as the hitting mat. We also recommend 
changing the ‘Delay’ setting in the software to Medium for iron capture.   
 

Will Vector Pro work for a left handed player? 
Yes. The software will auto-detect Right or Left handed.  You will need 
to reposition the unit on the other side, but there is no need to make 
any adjustments to the software.   
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Does AccuSport provide product training? 
The Vector Pro Launch System is the industry leading launch monitor 
with a host of features. Training packages are available at an extra cost. 
For details, contact Customer Support.  
 

Do I need to register my Vector Pro? 
Yes.  Registering your Vector Pro will activate your warranty. In 
addition, it will assure that your contact information is entered into our 
system so that you can receive software announcements and technical 
support for the warranty period. You can register your Vector Pro at 
www.accusport.com or by contacting Customer Support.  
 

Will Vector Pro work on an Apple Mac? 
No. The Vector Pro Launch System will only work on 32-bit or 64-bit 
Personal Computers (PCs) running Windows XP Home or Professional, 
Windows Vista, and Windows 7 Operating Systems. 
 

How accurate is club speed? 
Vector Pro club speed is accurate to within 2 mph. This calculation is 
derived from ball speed, launch angle, back spin, side spin and 
push/pull, all of which are measured parameters.   
 

Is there a chart for optimal launch angle and spin rate? 
Since each golfer’s swing is different, there are too many variables for a 
printed chart. However, you can use the “what if” feature of the VFit 
Analysis Screen to enter different shot information - such as launch 
angle and spin rate - in order to determine the impact of these changes 
on an individual golfer’s ball flight. 
 

Why is the green power light on the Vector Pro blinking? 
The green LED power light on the side of Vector Pro glows when Vector 
Pro is powered on. It blinks when the internal battery is not fully 
charged. If the battery is low and needs charging, Vector Pro will emit a 
beeping sound. 
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Using Vector Pro 

How important is ball placement?   
Ball placement is crucial. If the ball is not placed in the correct hitting 
area or is not at the stated 14 inches, +/- 1 inch, from the launch 
monitor, the ball capture or launch data will be affected. The Setup 
Template indicates where the ball should be placed for set-up and 
hitting. 

How do I charge the battery? 
To charge, plug the Vector Pro into an outlet via the AC adapter.  
Making sure the power on the Vector Pro unit is “Off”, allow the unit to 
charge overnight or for at least six hours. 

Do the preference settings have a significant impact on ball 
flight? 
Preferences related to altitude and weather do impact ball flight. The 
ball will fly higher and farther at high altitude than at sea level. 
Therefore, if you set your preferences for Colorado, and then take your 
Vector Pro to Florida, you must change the preferences, or Vector Pro 
will show the ball going farther and higher than it would actually travel. 
For the most accurate readings, you should set the preferences 
according to the conditions that you are in. 
 
Wind direction should be set at zero degrees if the ball flies directly into 
the wind, at 180 degrees if the ball flies downwind, at 90 degrees if the 
wind is coming from the right, and at 270 degrees if the wind is coming 
from the left.  

Does it matter what kind of golf balls I use? 
We recommend using a white ball with as few markings as possible, so 
that the software can clearly read the straight lined type logo, or line 
you have drawn on the ball. Be sure the ball is properly marked (page 
20.)  Range balls or limited flight balls will affect measured launch data. 
 

What are the Marks, Mono, Plane, Edges, and Ball Outline check-
boxes in Advanced Settings for? 
First, remember that anything in Advance Settings is for experienced 
users only. If you are an experienced user then this explanation will be 
helpful to you.  
 
Marks: show what the software recognizes as significant marks on the 
golf ball. Ideally, the logo used or black line should be the only, or at 
least the predominant mark highlighted in blue. 
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Mono: allows you to check the brightness setting. When the Mono 
button is checked, the white circle in place of the golf ball should extend 
to the edges of the ball. If it does not, recalibrate the Vector Pro with 
the tee position 14 inches away.   
Plane: displays a plain red line around the golf ball. If using a black line 
or logo, the red line should overlap it. This confirms that the software is 
reading the marks on the ball correctly.  
Edges: maps the individual edge points in relation to the center of the 
golf ball. 
Ball Outline: maps the actual circumference in relation to the center 
point of the golf ball. 
 
How Should I setup the Vector Pro when using a White Headed 
Driver or Fairway Wood 
 
When fitting clubs with white heads the club head can appear in the ball 
capture window. This can cause incorrect readings in the software. The 
following setup should prevent this problem. 
The tee position should 
remain approximately 
12-14 inches away 
from the launch 
monitor. However, 
when using white 
headed clubs, move 
the ball behind the 
back edge of the 
monitor 2-3 inches, as 
pictured. This will 
prevent the image of 
the golf club from 
being captured by the 
launch monitor. To capture the shot correctly a change to the software 
Trigger Delay settings may also be needed. Players with a fast to 

moderate ball speed should select a Fast (F) Trigger 
Delay setting. If the player has a slower swing speed 
and would like to use a white driver on a Vector Pro, the 
Trigger delay setting should be changed to Medium 
(M). This allows more time to get the ball within the 
shot capture window. 
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Troubleshooting 

When I try to load the drivers an error message appears telling 
me there is no information on my hardware contained in the file.   
Contact Customer Support: (866) 759-3302 or support@accusport.com 

I’m getting an error message that says this device is not 
recognized.  
Contact Customer Support. 
 
 
The Driver Installation Problem Solving Procedure below addresses the 
following questions and problems: 

How do I update the Vector Pro driver? 

The Hardware Update Wizard does not appear when I turn on my 
Vector Pro for the first time? 

The User Guide says I will need to install four drivers but only 
two instances of the wizard appear? 
 
For these driver installation issues, use this procedure: 
 

Driver Installation Problem Solving Procedure  

1. In Windows click Start. 

2. Right Click My Computer. 

3. Click Manage. 

4. Click Device Manager. 

The right window panel shows hardware currently installed or 
connected to your computer. The window will look similar to one of 
the following images: (next page) 
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The yellow question marks or exclamation marks indicate that these 
drivers need to be installed using the procedures on page 14 for 
Windows XP, page 17 for Windows Vista and Windows 7. 
 

Yellow marks indicate 
uninstalled USB device. 

Yellow marks indicate 
uninstalled USB device. 
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The logo or line on the ball is not visible on the image. 
1. Select Options and Calibrate to re-calibrate the lenses. 

 
2. Make sure that the logo or line is vertical and faces the right edge 

of the Vector Pro when you tee up the ball.  
 

I hit one shot and software will not capture any more. 
Your computer’s processor may not be running at full speed or the 
computer may have tried to enter sleep mode. Make sure that your 
computer processor is running at full speed: 
 

1. Click on the windows Start button 
2. Right click Control Panel 
3. Select Performance and Maintenance 
4. Double left click Power Options. (If using windows classic look, 

you should go straight to the Power Options icon and double left 
click.)  

5. From the Power Schemes drop down box, select Always On, 
select Apply, then OK. Then restart your computer. 

 
6. If this does not solve the problem, call Customer Support. 

 
There is part, one, or no golf balls on the screen.  

1. Be sure Vector Pro is on the same level as the mat.   
 

2. If the ball image is cut off at the side, use the setup template to 
verify that you are teeing up the ball correctly and that it is 14 
inches from the Vector Pro.  

 
3. Click Options on the menu bar and select Advanced Mode.  Verify 

that the ‘Default’ box is checked for trigger sensitivity, located in 
the lower left corner. 

 
4. Click Options on the menu bar and select Advanced Mode.  Verify 

that Fast is being used for drivers and Medium for irons or slow 
swing speeds.  
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I am getting launch data for drivers, but the system is not 
capturing irons. 
 

1. Make sure that Vector Pro is on the same level as the mat and 
that the ball is not being hit below the cameras. 

 
2. Click Options on the menu bar and select Advanced Mode.  Verify 

that the ‘Default’ box is checked for trigger sensitivity, located in 
the lower left corner.   

 
3. If the ball image is cut off at the side of the screen, use the setup 

template to verify that you are teeing up the ball correctly. 
 

4. If your swing speed with an iron is less than 80 mph, change the 
Delay setting in Advanced Mode to Medium.  

 
5. Tee up the ball a bit closer to the center line straight out from the 

Vector Pro lenses, still 14 inches away from the unit. 

I am getting strange or incorrect readings. 
This may be due to lighting conditions, loss of calibration, incorrect 
system preferences or low battery.  
 

1. Select Options and Calibrate from the menu bar and recalibrate 
the lenses.  

 
2. Make sure the ball is marked properly, and that the software is 

reading the correct mark, not some other spot on the ball.  
 

3. If the problem persists, click Options/ Preferences in the menu bar 
of the software, and make sure the wind speed, altitude and 
temperature settings are correct.  

 
4. If the battery is low, charge it or use an alternate power source. 

 
The ball image screen is completely white.  

Go to Options>Advanced Mode and verify that the ‘Mono’ box is not 
checked.  
 

I cannot see the stripe on the balls. 
Make sure when placing the ball in front of Vector Pro that the black line 
is vertically facing the Vector Pro. 
 



User Guide Page 69 April 2012 

 

The golf ball is blurry. 
Select Options and Calibrate from the menu bar and recalibrate the 
lenses.  
 
 
My software screen looked corrupted. 
Make sure to close the software before making any changes to your 
monitor’s resolution.   
 
 
Error Messages 

Analysis Terminated  
This message indicates that the ball strike has not been correctly 
captured. If the ball image is cut off at the top of the screen, ensure the 
Vector Pro is level to your hitting surface or tilt Vector Pro back slightly. 
If the ball image is cut off at the side, use the setup template to verify 
that you are teeing up the ball correctly and that it is 14 inches from the 
unit and modify the delay settings in Advanced Mode.  Typically Fast 
delay is ideal for drivers and Medium delay is used for irons or slower 
swing speeds.  
 
 
Ball too close 
The ball is less than 12 inches away from the Vector Pro. Be sure that 
the golf ball has been teed up/placed 14 inches from the Vector Pro and 
hit another shot. 
 
 
Ball too far 
The ball is greater than 18 inches away from the Vector Pro. Be sure 
that the golf ball has been teed up/placed 14 inches from the Vector Pro 
and hit another shot. 
 
Check Ball Speed  
The ball speed is either less than 21mph or greater than 235 mph. This 
message could also be caused by incorrect ball markings. 
 
Check Launch Angle 
Be sure that the Vector Pro preferences are not incorrectly set to left 
handed for a right handed player or to right handed for a left handed 
player. This may also indicate a topped shot. 
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Check Side Angle 
The side angle is greater than (+/- 12 degrees). 

 

Low Ball Edge Quality 
The ball/ tee placement is incorrect. Use the supplied template to 
ensure that the ball was hit at the required 14 inches from Vector Pro 
and from within the appropriate hitting zone. If the distance is correct, 
select Options and Calibrate from the menu bar to recalibrate the 
lenses.   
 
Low Planes   
Balls may not have been marked properly. 
 

Marks too Small 
To be sure that Vector Pro can read the marks on the ball, first check 
that the logo or line is vertical and facing the right edge of the Vector 
Pro when you tee up the ball.  
 
If the ball is incorrectly marked or dirty, or if it has significant marks on 
it other than the logo or line, remark or change the ball. 
 

No Balls Found 
This message appears if none, one, or only part of a ball can be seen on 
the image screen. Use the setup template to ensure that the ball was hit 
at the required 14 inches from Vector Pro. 
 
Use the setup template to be sure that the ball was teed up in the 
proper hitting area. For right handed players, this is normally inside the 
right edge of the Vector Pro. For left handed players, this is normally 
inside the left edge of Vector Pro. 
 
For hitters with slower swing speeds, select Options and Advanced Mode 
from the menu bar and change the delay setting to Medium or Slow.  
Typically Fast is recommended for Drivers and Medium for irons or 
slower swing speeds. 
 
 
No Planes 
Balls may not have been marked properly, or ball may have been placed 
on the tee with marks facing away from Vector Pro.  
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APPENDIX 
 

Appendix A: Full Report 
 

Page 1: Displays a 
full view of the 
expanded Shot 
History table.  Each 
item’s average line 
and individual shots 
are displayed.   
 
 
 
 
 
 
 
 
 

 
 
 
 

 
Page 2: Displays 
the Top Down Shot 
Profile.  All individual 
shots are plotted 
according to the plot 
color assigned in the 
shot history table.   
 
Note: Averages are not 
plotted unless a color is 
manually selected by 
user in the Shot History 
table before generating 
the report 
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Page 3: Displays 
the Side View Shot 
Profile.  All individual 
shots are plotted 
according to the plot 
color assigned in the 
shot history table.   
 
Note: Averages are not 
plotted unless a color is 
manually selected by 
user in the Shot History 
table before generating 
the report 
 
 

 
 
 

 
 
 
 

Page 4: Displays 
any notes that were 
entered at the 
beginning of the 
reports generation 
process.   
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Appendix B: Averages Report 

 
Page 1: Displays 
the Shot History 
table in the 
collapsed Average 
comparison view.  
Only each item’s 
average line is 
displayed.   
 
 
 
 
 
 
 
 

 
 
 
 

 
Page 2: Displays 
the Top Down Shot 
Profile.  Only Item 
averages are plotted 
according to the plot 
color assigned in the 
shot history table.   
 
Note: Averages are 
automatically assigned a 
color when the average 
report is generated.   
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Page 3: Displays 
the Side View Shot 
Profile.  Only Item 
averages are plotted 
according to the plot 
color assigned in the 
shot history table.   
 
Note: Averages are 
automatically assigned a 
color when the average 
report is generated.   
 
 
 
 
 

 
 
 
 
 
 

Page 4: Displays 
any notes that were 
entered at the 
beginning of the 
reports generation 
process.   
 


